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This document confirms that products manufactured by

Duran Audio bearing the CE label meet all the requirements

in the EMC directive 2004/108/EC and LV directive

2006/95/EC laid down by the Member States Council for

adjustment of legal requirements. Furthermore the products

comply with the rules and regulations from 30 August 1995

referring to the electromagnetic compatibility of devices.

Duran Audio products bearing the CE label comply with the

following harmonised or national standards: 

EMC: 

EN 55103-1 :1996 EN 55103-2 :1996 

Safety:

IEC60065:2001 (ed7), A1:2005, A2:2010

CAN/CSA 60065-03 + Amd 1 and 

UL 60065-07 (pollution degree 2)

Mains Harmonics:

EN 61000-3-2 :2001 

Insulation:

Class1 

Duran Audio BV 

Koxkampseweg 10 

5301 KK Zaltbommel 

The Netherlands 

Tel: +31 418 515583 

Fax: +31 418 518077 

Zaltbommel, January 2012.

USER’S NOTICE AND DISCLAIMER: 

No part of this manual including the software described in

it may be reproduced, transmitted, transcribed, stored in a

database system or translated without the express written

permission of JBL Professional. 

Documentation kept by the end user for back-up purposes

is excluded from the above. 

All products and corporate names mentioned in this manual

may be registered trademarks or copyrights of their

respective companies. They are used here for indicative

purposes only. 

The information contained in this manual has been carefully

checked for accuracy; however no guarantee is given with

respect to its correctness. JBL Professional accepts no

responsibility or liability for any errors or inaccuracies that

may appear in this manual or the products and software

described in it. 

Specifications and information contained in this manual are

subject to change at any time without notice. 

© 1998-2014 JBL Professional. All rights reserved.

REFERENCE TO EC STATEMENT OF CONFORMITY



3201401/IvxIM_v2.2

JBL Intellivox Installation Manual

Reference to Statements of Conformity . . . . . . . . . . . . . . . . . . . 2

User’s Notice and disclaimer . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1. Important Safety Instructions. . . . . . . . . . . . . . . . . . . . . . . . . 4

2. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Applicable models and variants . . . . . . . . . . . . . . . . . . . . 5

What’s in the packaging. . . . . . . . . . . . . . . . . . . . . . . . . . 6

3. Installation Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Preparing for Installation . . . . . . . . . . . . . . . . . . . . . . . . . 7

Signal and Control cables . . . . . . . . . . . . . . . . . . . . . . . 7-8

Connector and wiring details . . . . . . . . . . . . . . . . . . . . 8-9

AC Mains . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

WAGO connectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Audio inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Network connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Fault monitoring/fan control connector. . . . . . . . . . . 13-14

External Ambient SPL/Temperature Sensor . . . . . . . . . . . 15

Mechanical Installation . . . . . . . . . . . . . . . . . . . . . . . . . 16

- Acoustic centre . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

- Mounting Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

- Mounting Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4. Unit checks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Connecting the PC to the Intellivox . . . . . . . . . . . . . . . . 19

Settings file upload . . . . . . . . . . . . . . . . . . . . . . . . . . 20-21

5. Appendix. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Optional accessories . . . . . . . . . . . . . . . . . . . . . . . . . 22-23

Common analogue grounding issues . . . . . . . . . . . . . . . 24

Software and firmware updates . . . . . . . . . . . . . . . . . . . 24

Network cables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Failure monitoring on 70 V/100 V connection. . . . . . . . . 25

- Configuring PCB960 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

- Configuring PCB124 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Failure Relay Configuration. . . . . . . . . . . . . . . . . . . . . . . 27

TABLE OF CONTENTS



4 201401/IvxIM_v2.2

JBL Intellivox Installation Manual

This symbol is intended to alert you to the

presence of uninsulated dangerous voltages

within the product's enclosure that may be of

sufficient magnitude to constitute a risk of

electric shock. 

This symbol is used throughout this manual and

is intended to alert you to the presence of

important instructions. 

1) Read these instructions. 

2) Keep these instructions. 

3) Heed all warnings. 

4) Follow all instructions. 

5) Do not use this apparatus near water. 

6) Clean only with dry cloth. 

7) Do not block any ventilation openings. Install in

accordance with the manufacturer's instructions. 

8) Do not install near any heat sources such as radiators,

heat registers, stoves, or other apparatus (including

amplifiers) that produce heat. 

9) Do not defeat the safety purpose of the polarised or

grounding-type plug. A grounding-type plug has two blades

and a third grounding prong. The wide blade or the third

prong are provided for your safety. If the provided plug does

not fit into your outlet, consult an electrician for

replacement of the obsolete outlet. 

10) Protect the power cord from being walked on or

pinched particularly at plugs, convenience receptacles, and

the point where they exit from the apparatus. 

11) Only use attachments/accessories specified by the

manufacturer. 

12) Use only with the cart, stand, tripod, bracket or

table specified by the manufacturer, or sold with the

apparatus. When a cart is used, use caution when moving

the cart/apparatus combination to avoid injury from tip-over. 

13) Unplug this apparatus during lightning storms or when

unused for long periods of time. 

14) Refer servicing to qualified service personnel. Servicing

is required when the apparatus has been damaged in any

way, such as power-supply cord or plug is damaged, liquid

has been spilled or objects have fallen into the apparatus,

the apparatus has been exposed to rain or moisture, does

not operate normally, or has been dropped. 

Warning -To reduce the risk of fire or electric

shock, do not expose this apparatus to rain or

moisture and objects filled with liquids, such as vases,

should not be placed on this apparatus.

Warning - In order to disconnect this apparatus

from the mains power supply, the connector

should be removed from the mains socket located on the

amplifier module.

Warning - Do not expose the internal backup battery to

excessive heat such as sunshine, fire or the like.

Caution - Danger of explosion if the internal backup

battery is incorrectly replaced. Replace only with the same

or equivalent type.

Warning - The installer should ensure that the

mechanical mounting method employed should

be capable of supporting four times the weight of the unit

(i.e., with a safety factor of 4).  Always use all the brackets

provided with the unit. Only skilled persons may install

the units.

Warning - This apparatus is a Class I device and

must be connected to a mains socket outlet that

provides a safety ground connection.

1. IMPORTANT SAFETY INSTRUCTIONS
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This manual describes the recommended installation

procedure for the JBL Intellivox DC (DDC2.0) and DS (DDS)

range of loudspeakers.

The JBL Intellivox is a type of loudspeaker known as an

active DSP-controlled loudspeaker array, which utilises the

principle of multiple, individually-driven loudspeaker drive

units in the vertical plane at specific spacings. In addition to

the drive units, the Intellivox housing contains a mains-

powered electronics module containing multiple power

amplifier channels and a Digital Signal Processing (DSP)

section. 

This manual describes the following aspects of an

installation: 

• Necessary cabling

• Connector wiring

• Mechanical installation

After installation, the loudspeaker should be tested for basic

functionality using  JBL WinControl software; the manual

also describes this procedure. (Note that full configuration

and control of the loudspeaker is beyond the scope of this

manual; this topic is fully documented in the WinControl

Help files.)

Please note that a full range of optional

mounting brackets and connection coverboxes

are available. Please refer to our website for

further details.

APPLICABLE MODELS, AND VARIANTS

The various models in the Intellivox range are fitted with

different numbers of drive units.

This manual applies to the following JBL 

Intellivox models:

Intellivox-Intellivox-DC115, DS115 and DSH115* (fig.1a)

Intellivox-DC180, DS180 and DSX180  (fig.1b)

Intellivox-DC280, DS280, DSX280 and DSX280HD** (fig.1c)

Intellivox-DC380, DS380 and DSX380  (fig.1d)

Intellivox-DC430, DS430 and DSX430  (fig.1e)

Intellivox-DC500, DS500 and DSX500  (fig.1f)

The DS and DSX models use a different DSP algorithm from

the DC models, and the DSX models use two different types

of drive units in each loudspeaker instead of the DS’s single

type†. These model differences may be ignored for the

purposes of installation and commissioning.

2. INTRODUCTION

fig.1

The Intellivox models covered by this manual
a b c d e f

* The DSH models are 'high-frequency-only' and can be
used to augment an existing DS model.

** Models with the HD suffix offer increased directivity
control for high frequencies.

†The DC115 & DS115 models are an exception, also
employing two different driver types.
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A standard option applicable to all models is the position

within the housing of the electronics module, which may

either be at the top or bottom of the housing.  The position

is relevant to the installation procedure as the “acoustic

centre” (see fig 2) of the loudspeaker array will be different

in the two cases. It is not possible for the electronics

module’s position to be changed after production.

A further option available to special order is for the

electronics module to be mounted at the rear of the unit.

This results in a loudspeaker with different dimensions from

the standard models, requiring a different mounting

procedure. Note that this manual is NOT applicable to these

versions; please contact JBL for more information.

Reference point for
acoustical mounting 

height

DC115 
amp at bottom

DC115 
amp at top

Reference point for
acoustical mounting 

height

WHAT’S IN THE PACKAGING

In addition to the loudspeaker itself, each unit is shipped 

with the following items:

• Installation manual (this document)

• Datasheet specific to the model

• Box containing:

A

B I

C

JG

D
E

F H

REF ITEM QTY USE

A Mounting brackets 2 or 3* Speaker  mounting

B Set of 30 mm hex-head screws with washers and wall plugs 4 or 6* Mounting bracket fixings 
(wall)

C Female IEC mains connector 1 AC input

D 6-pole female WAGO connector, with cover 1 Mating connector
for audio

E 5-pole female WAGO connector, with cover 1 Mating connector for 
RS-485 control port

F, G Set of PVC inserts for WAGO connectors, with wire insertion tool 1 WAGO connector wiring

H Set of M4 x 10 round-head screws with star retaining washers 4 or 8* Grille retaining screws

I M5 x 12 pan-head screws with shakeproof washers 8 or 12* Mounting bracket fixings 
(loudspeaker)

J Caution Label 1 Mains cable labeling

* depending on model

fig.2

fig.3 - Box contents

The mounting brackets, screws and wall plugs as well as the connector set are packed together in a

separate box enclosed in the main packaging.
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PREPARING FOR INSTALLATION

Before starting to install the Intellivox loudspeaker, a

number of points should be considered.

• It is assumed that the installation site has been the

subject of an extensive DDA investigation or optimisation

prior to the actual install. (DDA = Digital Directivity

Analysis, the proprietary simulation and optimisation

software for these products*). This procedure will have

identified the optimum physical location for the Intellivox,

to accurately achieve the desired acoustic coverage. In

particular, the “acoustic centre” position will have been

specified, in terms of height above the finished floor. The

installer should confirm that he/she has 

this information.

• Unless specified otherwise by the sound system

designer, the Intellivox column should be installed at a

position exactly perpendicular to the listening plane (i.e.

vertical if the floor is horizontal). Unlike conventional

loudspeaker systems, minor mechanical misalignment may

lead to degraded coverage and intelligibility. Ensure (by use

of a levelling device such as a spirit level) that the surface

to which the Intellivox is to be attached is absolutely

vertical and that all mounting positions (2 or 3 depending

on model) are in the same plane.

• The Intellivox is configured to operate from either  

230 V or 115 V AC mains.  A suitable AC mains outlet should

be provided adjacent to the loudspeaker’s intended mounting

position, taking the position of the electronics module into

account. The outlet must be on a circuit able to handle the

full-load power consumption as well as supply the maximum

in-rush current drawn by the electronics module; these figures

vary with model, and can be found in the datasheet supplied

with the unit. The third terminal of the mains outlet must be

connected to a proper safety ground. Local safety regulations

may require a separate mains distribution network or an

uninterruptible mains power supply (UPS).

SIGNAL AND CONTROL CABLES

• In addition to the mains supply, some or all of the following

cables (shown in fig 4) will need to be run to the loudspeaker

position. The necessity for each of these will have been

determined by the system designer; the installer should ensure

that he/she has these details to hand. Depending on the specific

access issues, it may be better to ensure that these cables are

in place and correctly terminated “ready-to-plug-in” before the

Intellivox is mounted in position. All wiring details can be found

on pages 9-15.

• Audio inputs: the Intellivox accepts line level audio 

(0 dBV). Two separate transformer-balanced audio inputs

are provided; however, units are shipped with only input 1

active. Input 2 can be made active via WinControl.

Alternative input sections are available separately:

accepting either one line level input and one 70 V/100 V

input or two 70 V/100 V inputs. This option needs to be

specified at the time of ordering.

• Network connection: all Intellivox products are

configured, and may also be monitored, from a PC running

WinControl software. With all installations it will be 

3. INSTALLATION GUIDE

*Authorised electro-acoustic consultants or 'build & design' sound contractors can apply for a DDA License free of charge.
This license can be obtained through our website at http://www.jblpro.com/
For further information please refer to the Help files and manual with the DDA software.

Audio

RS-485

AC Mains
supply

External
Ambient noise 
+ Temperature

sensor

Failure Relay / 
Fan Control

REQUIRED
CONNECTIONS

OPTIONAL
CONNECTIONS

fig.4 - Intellivox Connections
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necessary to upload the correct settings for each unit to

obtain the desired acoustic coverage. Once this has been

done, there is no longer an operational need to have the

Intellivox connected to a PC because all settings are stored

locally within the unit’s memory and in the event of a power

failure, will be automatically reloaded on power-up. The

system designer will have determined whether a permanent

network connection needs to be provided. This will be the

case if the Intellivox is to be monitored remotely during

normal operation. Otherwise, the network wiring can be

omitted, but consideration should still be given to the unit’s

location with regard to ease of both initial and future

access for a PC connection. It may be appropriate to install

network wiring in order to provide a network access point

at a location more easily accessible than the rear of the

Intellivox unit itself. A cable with two individually foil-

screened twisted pairs should be used. Details of suitable

cables can be found on page 24. 

• Fault monitoring: if network monitoring is not to be

used, a simple surveillance function may be realised by

means of the Intellivox’s ‘failure detect’ volt-free relay. This

connection requires a 2-core cable.

• Additional cooling: if the ambient temperature is

expected to exceed 40 °C an external fan should be

installed. This may be activated automatically via the

Intellivox’s temperature-controlled fan output; 2-core cable

will be required. The fan should be mounted in a position

which ensures sufficient airflow around the heatsink. For

outdoor applications a weather-proofing kit is available as

an option (see accessories in the appendix).

• Ambient Noise Sensing: the Intellivox is equipped with

a built-in microphone to provide a signal for its embedded

autogain algorithm, but an external ambient microphone

(available as an option*) should be connected if specified

by the system designer. Standard screened two-core

microphone cable should be used for this purpose.

• Frost protection: the Intellivox is equipped with a frost

protection system which activates an internally generated

pilot tone if the ambient temperature drops below a pre-

determined threshold. The frost protection thresholds can

be set using WinControl. If this function is required, an

external ambient temperature sensor (available as an

option*) should be connected with screened two-core cable

(or similar) for its correct operation.

CONNECTOR AND WIRING DETAILS

All connections to the Intellivox (except mains power) are

made via the connector block at one end of the electronics

module. The IEC mains socket is immediately adjacent to

the connector block.

*Note that the optional external ANS microphone is combined with a temperature sensor in a single unit (JBL Order Code
97661101). If both functions are required, the use of 2-pair screened cable is recommended.

USE ONLY 230V FUSES

Audio input
connector

Network
connector

fig.5.1 - Intellivox Connector block
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Additional access to the connectors is available via the
connector plate located between the amplifier and
loudspeaker baffle. Removal of the front grille will be
necessary to gain access.

AC MAINS

The Intellivox is equipped with a 3-pin IEC

mains connector with an integral fuse holder.

Only ever replace the fuse with one of the same type and

rating. Never attempt to replace a fuse without first

removing the IEC plug from the unit. Be sure that the mains

voltage stated on the unit complies with the local standard

before connecting the Intellivox to the mains supply. Be sure

to use the appropriate cable diameter for the power

consumption of your particular Intellivox model.

A pre-made IEC mains cable (with the appropriate plug for

the territory) may be used if one of a suitable length is

available. Otherwise, use the mating IEC cable socket

supplied, and wire to the intended mains outlet. Note that

this connector is only suitable for use with stranded

“appliance” cable, not rigid mains installation cable.

A stranded wire clamp is available from JBL to make the

transition from rigid mains installation wiring to stranded

appliance cable, should no    suitable mains outlet or

connection plate be available. Refer to page 22 for ordering

information. 

Warning – This apparatus is a Class I device

and must be connected to a mains socket

outlet that provides a safety ground connection.

TERM EURO USA
L Brown Black
E Green/yellow Green
N Blue White

fig.5.2 - Additional access to connector block via
the  front cover plate

fig.6.1 - IEC mains cable wiring

L E
N

fig.6.2 IEC mains cable label

Warning – The caution label contained in the

Intellivox standard connector set must be

placed in close proximity to the IEC female

cable plug as indicated in fig.6.2.
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WAGO CONNECTORS

All other Intellivox connections are made via the four on-

board WAGO Type 231 multi-pin connectors. These are:

• Audio (6-way male)

• Network (5-way male)

• Ambient noise mic/Ext. temp. sensor (5-way female)

• Failure detection/Fan control (5-way female)

One 5-way and one 6-way mating female connector is

supplied with every unit for the network and audio

connections. 5-way mating male connectors for the other

two sockets are available separately from JBL if required

(see page 22), but will be shipped with the unit if specified

at the time of order. 

To wire the WAGO Type 231 connectors, proceed as follows:

1) Prepare the cable; strip back approximately 8-9 mm

(0.35”) of the insulation of each core.

2) Refer to the table below: select the appropriate PVC

insert for the wire size. If the wire is too big for the largest

size insert, the inserts can be ignored and the wire

connected directly (next step). Insert the wire into the insert

so that the bare end goes through the hole but the

insulated portion does not.

3) Using the wire insertion tool supplied as shown below,

open the clamp contact in the connector shell by pressing

inwards towards the shell. 

4) Insert the stripped wire, with or without a PVC insert,

into the hole as shown. If using an insert, ensure that it is

fully seated. Release the wire insertion tool, and check that

the wire is secured. Repeat from Step 2 for all other cores.

WIRE SIZE INSERT COLOUR

0.08 to 0.2 mm2 White

0.25 to 0.5 mm2 Light grey

0.75 to 1.0 mm2 Dark grey

fig.7.1 - Inserts

fig.7.2 -  Using the WAGO insertion tool
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AUDIO INPUTS

The Intellivox is normally supplied with two transformer-

balanced line inputs. Selection of Input 1 or Input 2 as audio

source is made from the WinControl software via the

network, and for most installations only Input 1 need be

wired. However, Input 2 may be connected to a secondary

signal path (in case of a failure elsewhere in the system), or

to an emergency sound source.

For optimum results only use good quality balanced audio

cable consisting of a twisted pair and an overall screen. The

audio source(s) (e.g. the Octadrive) should have a low

impedance balanced output. The nominal line input level 

is 0 dBV. 

For applications requiring direct connection to a 70 V/100 V

distributed loudspeaker system the Intellivox may be

ordered with an alternative input module having either 

one 70 V/100 V audio input and one 0 dBV line level input

or two 70 V/100 V inputs. Refer to Appendix for order codes.

The audio connector pinout is as follows: 

If the source equipment has a well-designed balanced

output and the wiring strategy shown below is used, there

should be no problems with hum or other extraneous noise.

Note that pins 3 and 6 of the audio connector are analogue

audio grounds, they should be used only for connecting the

screen of the audio cables, and for no other purpose.

Due to the complex architecture of some large audio

systems, unexpected hum or noise may occur due to ground

loops, or injected noise from other equipment elsewhere in

the system. If this occurs, please refer to the Appendix (p24)

and to our website, where additional guidance on grounding

strategies will be found, with general techniques that may

be applied in order to reduce ground-induced noise.

PIN NO. STANDARD VERSION
1 X 70 V/100 V 

1 X LINE VERSION
DUAL 70 V/100 V 

VERSION

1
Line level

audio input 1
(0 dBV)

Line 1 +

70 V/100 V
input*

70 V/100 V +

70 V/100 V
input*

70 V/100 V +

2 Line 1 - 70 V/100 V - 70 V/100 V -

3 Line 1 Screen GND (n/c) GND (n/c)

4
Line level

audio input 2
(0 dBV)

Line 2 +
Line level

audio input 
(0 dBV)

Line +

70 V/100 V
input

70 V/100 V +

5 Line 2 - Line - 70 V/100 V -

6 Line 2 Screen Line Screen GND (n/c)

1

2

3

Balanced source
output (e.g. XLR)

Intellivox line level 
audio input

(Line 1 only shown)

LINE 1+
LINE 1 -
LINE 1 SCN

1
2
3
4
5
6

fig.8.1 - Audio input connections

fig.8.2 -  Balanced audio
connections

1 2 3 4 5 6 6 5 4 3 2 1

or

*A simple failure monitoring scheme based on impedance switching can be implemented on this 70 V/100 V input. 
Refer to the Appendix (page 25) for details.
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NETWORK CONNECTION

The RS-485 network connection should be permanently

wired in any of the following situations:

• The Intellivox is to be constantly monitored in operation.

•  The physical location of the Intellivox makes access to

the network connector problematical.

• It is not practical (e.g. on a large scale installation) to

configure each device locally.

The RS-485 interface permits multiple Intellivox units to be

“daisy-chained” in parallel, so that they are controlled by

the same PC. In such a system, each Intellivox must have its

own unique network address; this is determined via

WinControl for each individual loudspeaker.

The network connection should be wired as shown in the

table and diagram below:

Note that the table above contains information with respect

to 5-pin XLR wiring. A 5-pin XLR connector is commonly used

to connect the network to the USB to RS-485 converter.

Note that 2-pair, individually-screened cable should be used for

RS-485 connection. The transmit (Tx) and receive (Rx) balanced

data lines must be wired via their own twisted  pairs. 

CAT-5 type UTP or FTP cable is NOT suitable. Please refer to the

Appendix section of this manual for cable specifications.

The maximum cable length over which the network

connection will operate reliably depends on the cable type

and the baud rate used. With good quality cable, a safe

maximum figure (at 19.2 kbaud) is 2000 m. If the distance

is significantly longer than this, a network repeater will be

required. 

Before connecting multiple devices to the same

network subnet, ensure that their network

addresses do not overlap. Each device should be set to a

unique network address (determined via WinControl).

In some installations, it is normal practice to

disconnect the RS-485 network from the USB to

RS-485 converter at the host (computer) during normal

operation. This removes the possibility of extraneous data

being inadvertently transmitted over the network. In such a

situation, the converter is only reconnected when system

maintenance or checks are required. Disconnecting from the

converter in this way leaves the Rx lines of the devices

unterminated. In most situations this does not present any

problems, but with a large network in a hostile EMC

environment, it is recommended that the host Y and Z lines

(host Tx/device Rx) are terminated in a 100 ohm resistor for

normal operation. This can be easily achieved by plugging

the XLR5 female connector into a spare male connector with

the resistor on the appropriate pins. This termination can then

be removed and the converter reconnected when necessary.

(If there is any doubt about which pins should be terminated,

shorting all five pins will generally be equally effective.)

Further information on the RS-485 network can be found in

the RS-485 converter manual and in the WinControl Help files.

to other devices

unit 3 unit 2 unit 1

host

A
B
Y
Z

DGND

A
B
Y
Z

DGND

A
B
Y
Z

DGND

Y
Z
A
B
DGND

network cable
twin twisted
individually
shielded

A +

B -

Y +

Z -

DGND

RS-485 port

fig.9.1 - Multiple units “daisy chained” in parallel

fig.9.2 - Network connections

fig.9.3 - Twisted pairs

1 2 3 4 5 5 4 3 2 1

or

WAGO PIN NO. XLR5 PIN NO. LABELLED FUNCTION
1 5 A Data Rx +
2 4 B Data Rx -
3 3 Z Data Tx -
4 2 Y Data Tx +
5 1 DGND
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FAULT MONITORING/FAN CONTROL CONNECTOR

The pinout of this connector is as follows:

Although accessed via the same connector, the fan control

and failure relay functions are independent of each other

and either or both may be used, as required.

The diagram above illustrates how this connector may

typically be wired.

Please note that Failure Relay and SPL/Temp

sensor connectors are both of the same type,

do NOT interchange!

Fault Monitoring

The Intellivox includes a single-pole changeover relay

whose contacts are accessible on the Failure Relay

connector. The conditions under which the relay operates

are defined as part of the device configuration in

WinControl. The relay connections may be configured either

as volt-free, or with additional internal resistors to allow

them to be connected directly to impedance-sensing line

monitoring equipment*. This selection is made by moving

an internal PCB jumper, refer to the Appendix for details.

In volt-free operation, COM is connected to NC; a failure

condition causes COM to be connected to NO.

When configured for impedance-sensing use, the

impedance between COM and NC is 10k Ω and open-circuit

between COM and NO in normal operation. When a fault

condition occurs, the impedance between COM and NC

rises to 20k Ω, and COM is short-circuited to NO.

Impedance-sensing fault monitoring equipment may be

connected to COM and NC.

The relay contacts have maximum current and voltage

ratings of 100 mA and 24 V respectively.

PIN NO. LABELLED USE

1 COM Failure relay Common

2 NO Failure relay Normally Open

3 NC Failure relay Normally Closed

4 + Fan +

5 - Fan -

To external 
fault reporting 

system

Intellivox

Failure
Relay

Fan control 
signal

24 V DC

FAN –
FAN +

FAULT NC
FAULT NO

FAULT COM

(OR)

24 V
Fan

fig.10.1 - Failure relay / fan control connector

fig.10.2 Fault monitoring / fan control connections

5 4 3 2 1 1 2 3 4 5
or

*Intellivox devices with early serial numbers do not have
the option of re-configuring the volt-free relay contacts
for impedance-sensing operation. Please contact the
service department for more information.
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Fan Control

An external cooling fan should be installed if the ambient

temperature is expected to exceed 40 °C and/or the

Intellivox will be exposed to direct sunlight. For outdoor

applications JBL offers an off-the-shelf solution (see

weather-proofing kit in the appendix). Dedicated forced

cooling solutions however can be constructed by means

of the information provided in this section.

An internal temperature-controlled output is available at

two pins of the connector; these pins should be wired to an

external 24 V DC fan as indicated in fig 10.2. One of the

pins is connected to an internal positive supply rail (FAN+,

approximately 24 V), the other one (FAN-) is driven by an

internal transistor. Note that external protection diodes are

normally not required, the FAN- signal is diode-clamped

both to the internal positive supply rail as well as to the

internal GND. 

The fan should be a 24 V DC type consuming less than 3 W.

Applicable fan types are:

EBM-Papst 8314.

EBM-Papst 8414.

Sunon KDE2408.

Please note that the FAN- signal is a PWM

(Pulse Width Modulated) signal. This control

results in a temperature dependent fan speed.

It implies that this signal cannot be used to directly drive

an external relay (e.g. to control a mains-voltage fan).

Contact JBL for details with respect to the interfacing to

mains-voltage fans.

Ensure that the airflow of the fan enhances

the natural airflow (caused by convection).

Note that the supply available at the fan

control connector has a maximum current

rating of 125 mA. Fans or any other loads

consuming more than 3 W should not be connected. This

might result in the activation of an internal protection*.

*For Intellivox devices with early serial numbers this
protection is non-resetable. Please contact the service
department for more information. 
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EXTERNAL AMBIENT SPL/TEMPERATURE SENSOR

The pinout of this connector is as follows:

Although accessed via the same connector, the external

ANS microphone and temperature sensor functions are

independent of each other and either or both may be used,

as required. The use of the optional JBL combined Ambient

SPL/Temperature sensor is recommended, although either

of the two functions may be used alone if wished.

The diagram above illustrates how this connector should

be wired to the optional combined sensor using twin

twisted-pair cable with an overall screen. Note that there

are two AGND terminals on both the Intellivox and the

sensor; care should be taken not to confuse these, and in

particular, not to connect AGND to GND at any time.

External Ambient SPL Sensor

The Intellivox incorporates an autogain algorithm which

intelligently alters the volume of the audio according to the

ambient noise level. An internal microphone is fitted to

monitor the ambient noise level in the gaps in programme

material. The autogain function is activated and adjusted

via WinControl. This automatic volume adaptation feature

will only give good results if the signal measured by the

microphone is truly representative of the diffuse ambient

noise level, and in some circumstances it may be preferable

to monitor the ambient noise at a position remote from the

Intellivox itself. Connecting the external ambient noise

sensor automatically disconnects the internal microphone.

Care should be taken in selecting a suitable location for the

external sensor; it should not be near direct sound sources

such as people talking, air conditioning system outlets, or

other constant noise sources such as electrical plant, etc.

The most favourable external sensor locations are walls or

ceilings (height > 3 m) within the coverage range of the

Intellivox.

Temperature sensor

The external temperature sensor is for activating the

Intellivox’s frost detection system, and should be

connected if it is anticipated that the ambient temperature

may drop below 0 °C. If it does, an internally-generated

pilot tone is applied to the drivers, warming the voice coils

slightly, and thus preventing any build-up of moisture in

the magnet gap. Note that this pilot tone is always

generated if the internal load monitoring surveillance

function is enabled. In that case the ambient temperature

sensor is not required.

PIN NO. LABELLED FUNCTION

1 MIC ANS mic +

2 AGND ANS mic -

3 NTC Temp Sensor +

4 AGND Temp Sensor -

5 GND Screen

NTC
AGND

Mic
AGND
Shield
Shield

AMBIENT SPL/ 
TEMPERATURE

SENSOR

5
4
3
2
1

Pair 1 Pair 1

Pair 2 Pair 2

INTELLIVOX

fig.11.1 - External ambient SPL/Temperature 
sensor connector

fig.11.2 - External ambient SPL/Temperature 
sensor connections

5 4 3 2 1 1 2 3 4 5
or



16 201401/IvxIM_v2.2

JBL Intellivox Installation Manual

MECHANICAL INSTALLATION

Acoustic Centre

Mounting an Intellivox loudspeaker is a straightforward

procedure, but it is essential to understand that the height

of the unit above floor level is extremely critical. The

“correct operational height” is defined as part of the

acoustical design process and the installer should make

sure that he/she has this information before commencing to

mount the Intellivox.

The correct operational height defined by the system

designer is the height of the Intellivox’s acoustic centre. This

point does not necessarily coincide with the position of any

particular physical component on the unit. The location of

the speaker’s acoustic centre is marked by the centre of the

yellow sticker on the front face of the unit at the time of

shipping, and it is this position that must correspond to the

operational height defined in the design process. The

“vertical” position of the acoustic centre relative to the

bottom of the unit varies from one Intellivox model to

another, though it will always be on the vertical centre line.

When calculating the positions for the mountings (see page

18), the distance from the acoustic centre to the top or

bottom of the loudspeaker (whichever is being used as the

reference datum) should be measured and then allowed for

when marking the mounting positions. The model-specific

specification sheet supplied with each loudspeaker includes

a mechanical drawing clearly showing the mounting

position locations.

Because of the extreme tight vertical radiation pattern of

the Intellivox, a small deviation from the calculated

acoustical mounting height may cause severe degradation

of the expected performance. 

Note also that the yellow sticker indicates

which way is “up”; ensure that this orientation

is observed.

Ensure the protective blue foam behind the

grille is removed before operation.

fig.12 Sticker showing acoustic centre and unit orientation
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Mounting Options

The Intellivox has two or three (depending on the model)

attachment points at the rear of the enclosure; the device

should be mounted using the appropriate brackets fixed at

these points. Each point consists of four M5 threaded

inserts and only the screws supplied with the original

mounting hardware should be used.

The threaded inserts are M5 metric and the

depth is 16 mm.

There are three options for mounting the Intellivox column:

1. The first (and most often used) method is to use the

standard mounting brackets supplied with the unit. 

Two or three brackets will be supplied, according to the

Intellivox model. Dimensions of the bracket are shown in

the drawing below. 

The standard brackets allow mounting of the Intellivox on

a straight wall or on a curved surface (e.g., a pillar) with a

gap of 25 mm (1.0”) between the rear of the enclosure and

the wall. If the unit requires three mounting points (as on

the larger Intellivox models) ensure that all three points are

in the same plane, to avoid the unit being bent when the

screws are tightened.

The mounting procedure is given on page 18 under

“Mounting Procedure”.

2. A second method is to mount the Intellivox using

(optional) swivel brackets which allow the plane of the

column’s vertical radiating axis to be at an angle other than

90 degrees to the wall. In this case two or three (depending

on the model) swivel brackets are needed. The horizontal

angle of the swivel brackets can be secured by the

hexagonal nut. The swivel brackets are mounted to the rear 

of the enclosure by the four M5 pan head screws instead of

the standard brackets. Two versions of swivel bracket are

available, permitting the Intellivox to be rotated through

45 or 90 degrees either way respectively. Refer to page 22

for ordering information.

3. The third method is to mount the column within a

recess in the wall or dedicated mounting panel so that the

front of the unit is flush. This is a specialised mounting

situation which will be encountered only rarely. In this case

longer M5 screws than those supplied will be required, and

it should be noted that the threaded inserts on the rear of

the enclosure are 16 mm deep. Access to the rear of the

unit will still be required for the cables. Because of the

proximity of the unit to the walls, particular attention

should be paid to the avoidance of acoustic resonances.

With all mounting methods, it is advised to keep the rear

side of the Intellivox free from the wall in order to prevent

unwanted resonances. If mounting the unit onto or into a

cavity wall, it is advisable to insert rockwool or similar

sound-absorbing material into the cavity in the vicinity of

the loudspeaker. 

An Intellivox Accessories brochure, which includes a full

range of optional brackets for various situations can be

downloaded from http://www.jblpro.com

fig.13.1 - Standard bracket dimensions in mm

fig.13.2 -
Direction of 
rotation 
when using
swivel brackets
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Mounting Procedure

The general mounting procedure using the standard

brackets is described below. It is assumed that all necessary

cabling is already prepared with connectors fitted as

described in the previous chapters.

Proceed as follows: 

1. Use of the wall plugs and hexagon head screws

supplied is recommended. If using other types, ensure

that the “across-flats” head size does not exceed 

11.5 mm (0.45”). 

2. Mark and drill the holes (8 mm) for the wall plugs. Use

the two holes with the slots running vertically (refer to

Fig 13.1). 

3. Insert the plugs and screws into the holes. Tighten the

screws with a spanner, but stop with a few mm of screw

shaft visible between the head and the wall. 

4. Check that it is possible to slide a bracket over the

heads.

5. Check that the chosen mounting points will position

the column in the correct vertical angle specified by the

acoustic design (which is usually exactly perpendicular

to the listening area). Use spacers on one or more of

the brackets if necessary.

6. Using a Philips H2 Screwdriver, attach the brackets to

the Intellivox enclosure with the M5 x 12 pan-head

screws and shakeproof washers supplied. The 10 mm

dia. holes allow screwdriver access to the screw heads.

7. Lift the Intellivox and slide the brackets over the heads

of the hex-head screws protruding from the wall. 

8. Firmly fasten the screws securing the brackets to the

wall. Re-check the verticality (or other angle if specified)

with a spirit level or similar levelling device.

9. Remove the front grille(s) from the Intellivox by gently

lifting the grille at the locations of the ‘snap-on’

fittings which hold it in place. Remove the protective

foam. Unscrew the four self-tapping screws securing

the  connector compartment cover and remove the

cover. Thread all cabling through the connector

compartment from the rear so that it is free and

accessible from the front.

10. Terminate and plug in all the connectors (see fig 5.1)

and replace the connector compartment cover and the

grille(s)*.

11. Secure grille(s) at each corner with supplied M4 round

head screws and star retaining washers. 

*If it is intended to connect a PC directly to the Intellivox to carry out the settings file upload (see page 19), leave the
network connector (if any) unplugged and do not replace the connector compartment cover until the upload and
verification procedure has been carried out.

fig.14 - Bracket attachment
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After installation and connection are complete, the installer

should upload the settings file into the Intellivox and verify

correct operation with WinControl software.

This section of the manual describes only the file upload

and a simple verification procedure. It assumes that a

laptop (or other computer) with both WinControl software

and a driver for the RS-485 interface already installed is

available, with the RS-485 interface. It also assumes that

the installer has the settings files, prepared by the system

designer, for each Intellivox loudspeaker making up the

system. These may be elsewhere on the laptop’s hard drive,

or may be supplied separately on removable media such as

a memory stick or a CD-ROM. No previous knowledge of

WinControl is necessary, but basic familiarity with Windows

file handling is required.

A full description of WinControl is beyond the scope of this

manual and further information is available in the

application’s Help files. Instructions on how to install

WinControl on a PC are included with the Program Set.

Instructions on the use of the RS-485 interface are included

with the interface itself.

CONNECTING THE PC TO THE INTELLIVOX

If connecting directly to the Intellivox, use the 5-pin XLR to

WAGO cable (supplied with the WinControl Program Set)

and plug the WAGO connector into the loudspeaker’s

network socket. Connect the other end to the RS-485

output socket on the RS-485 interface. If the network

connection to the Intellivox has been made permanent and

network access is consequently in a different physical

location, connect the PC at this point, using a different

(installation-specific) cable if necessary.

The RS-485 interface should then be connected to the

PC’s USB port.

4.UNIT CHECKS
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SETTINGS FILE UPLOAD

• Apply mains power to the Intellivox, turn on the PC and

launch WinControl. Open Options > Communications

options, and confirm that the Off-line box is unchecked

and that the correct COM port is selected. Close the

Communication options dialogue box. If the PC is

connected to only one Intellivox, a screen similar to that

shown below should now be displayed.

The green rectangle in the main pane represents the

Intellivox. The model number is shown below and the

unit’s current network address to the right. If a

complete network comprising multiple Intellivoxes is

being accessed, additional similar rectangles will be

displayed.

• If the display does not look like that shown, click on

Command > Netscan to force the PC to re-scan the

network. (This will be the case if the Intellivox(es) were

unpowered when WinControl was launched.) If this fails

to produce the correct display, please check all network

connections, and that the correct port on the PC is

selected (open Options > Communications options

to do this).

• Select the Intellivox to have its settings file uploaded

by clicking on it once, highlighting its model number

and address, if it is not already highlighted. 

Click File > Load settings…, which will open the two

dialogue boxes shown below, Load control parameters

settings and Control parameters.

fig.15.1 - WinControl connected to single unit

fig.15.2 - Uploading the settings

File Name field Browse button
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• The File Name field (at the top of the Load control

parameters settings dialogue box) indicates the

last-used settings file name. If this is the first time

that the installation of WinControl has been used, a

default settings file is selected. The default location

for this file is in [My Documents folder]\Duran
Audio BV\WinControl\Settings, though as

this is alterable, it is possible that a different location

may be displayed, depending on how the particular PC

being used has been set up.  To navigate to the location

containing the settings file to be uploaded, click on the

Browse button (the folder symbol to the right of

the File Name field), which will open a further Open

dialogue box. Navigation may be continued in the

normal Windows manner. Note that Intellivox settings

files always have an *.ini file extension.

• Select the correct settings file and click Open. Then in

the Load control parameters settings dialogue box,

ensure that the proper parameter groups are selected

and specify the preset(s) to be uploaded, click OK* to

continue. An Info dialogue box will then open showing

additional information, in this box click OK to start the

upload process. This will transfer the pre-determined

Intellivox parameters to the loudspeaker. The Control

parameters dialogue box can now be closed and the

upload is complete.

• If there are further loudspeakers on the network to have

their settings files uploaded at this time, the procedure

can be repeated by selecting the next Intellivox. It is

possible to load the same settings file into several

Intellivoxes simultaneously, should the installation

require this. See Addresses and Groups in the

WinControl Help file for more information.

* See WinControl Help files for information regarding further Load options.
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OPTIONAL ACCESSORIES

Listed below are a number of additional components which may be required for an individual installation.

Mating connectors and components for external wiring:

Other installation-related accessories:

5. APPENDIX

CONNECTOR DESCRIPTION ORDER CODE

Mains power IEC socket 6A 17824103

Audio Input WAGO 6-pin female 17959146

Network WAGO 5-pin female 17959145

Failure/Fan or Ext SPL Mic/Temp. WAGO 5-pin male 17949145

DESCRIPTION ORDER CODE

WAGO stranded wire clamp 17969406

Intellivox wall bracket, 25 mm 802225 (2pcs); 802226 (3pcs)

Intellivox wall bracket, 35 mm 802235 (2pcs); 802236 (3pcs)

Intellivox wall bracket, 60 mm 802260 (2pcs); 802261 (3pcs)

Intellivox hinge bracket 90° 802000

Intellivox swivel bracket 90° 806608

Intellivox swivel bracket 45° 806618

Small Hinge 806602 (2pcs); 807402 (3pcs)

Cover plate with 2 x 13.5 mm cable gland holes 802110

Cover box, 42 mm, with 2 x 16 mm cable gland holes 802105

Cover box, 58 mm, with 2 x 25 mm cable gland holes 802100

Cover box, 42 mm, with 6 x XLR connectors 802120

Cover box, 42 mm, pre-punched for 6 x XLR connectors 191810043

External ambient mic/temperature sensor 97661101

WAGO wire inserts (white) for wire dias. 0.08 to 0.2 mm 17949605

WAGO wire inserts (light grey) for wire dias. 0.25 to 0.5 mm 17949615

WAGO wire inserts (dark grey) for wire dias. 0.75 to 1 mm 17949625

WAGO wire insertion tool 17949901
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Available input modules:

Weather proofing kits:

Network accessories:

DESCRIPTION ORDER CODE

Weather-proofing kit for Models DC115/180, DS115/180, DSX/180 (amp at top only) 20010

Weather-proofing kit for Models DC280, DC380, DS280, DS380, DSX280, DSX380, DSX280HD (amp at top only) 20012

Weather-proofing kit for Models DC430, DS430, DSX430 (amp at top only) 20014

Weather-proofing kit for Models DC500, DS500, DSX500 (amp at top only) 20016

DESCRIPTION ORDER CODE

Serial interface converter, USB to RS-485 387802

Program Set (inc. WinControl CD, USB interface, cable) 386602

DESCRIPTION ORDER CODE

1 x Line Level and 1 x 70V/100V 381001

Dual 70V/100V 381003

Dual 70V/100V with DC blocking 381005

DM1-TP Optocore SANE input board 381006
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COMMON ANALOGUE GROUNDING ISSUES 

Correctly connecting the Intellivox to ground has several

benefits:

1. Safety. The GND terminal of the IEC mains connector

provides a direct low impedance path from the

metal parts of the chassis to ground. Always

connect this terminal.

2. Reduction of RF emission. Although the Intellivox

electronics module is well shielded and external

connections are decoupled to prevent RF emission from

the internal high speed digital circuits, this protection

will not work properly if the chassis is not connected to

ground. 

3. RF Immunity. RF currents induced in the signal cables by

external RF fields are effectively shorted to chassis-

ground, provided that the cable screen (shield) is of

sufficiently low impedance.

In addition to the mains ground, the Intellivox connector

block has  ground pins marked in 3 different ways. Each

serves a dedicated purpose and care should be taken that

they are not interchanged or connected to each other.

• Pins marked GND are connected internally directly to

the chassis of the Intellivox. There are GND pins on the

audio line input connector and the ambient SPL

mic/temperature sensor connector. These GND pins are

for connecting the screen (shield) of the audio and

sensor cables.

• Two pins marked AGND  are fitted to the ambient SPL

mic and temperature sensor connector, and serve as a

signal reference only. AGND should not be connected

to any other ground pin (GND or DGND) on the chassis.

• The RS-485 connector has one pin marked DGND and is

intended as a terminal for the network cable screen

(shield). Since the RS-485 interface is optically isolated

(to prevent ground loops), DGND has no relation to the

chassis ground. DGND should not be connected to any

other ground pin (GND or AGND) on the chassis. 

SOFTWARE AND FIRMWARE UPDATES

The WinControl application is freely available and can be

downloaded from the download area of our website;

http://www.jblpro.com. We advise installers, users and

engineers to check our site regularly for updates. Intellivox

firmware and DSP software upgrades will also be made

available through the website.

For further information about how to use WinControl please

refer to the WinControl Help files. 

NETWORK CABLES

The  type of cable necessary for correct operation of the 

RS-485 network is twin twisted pair with each pair individually

shielded. Numerous cables of this type are readily available

and cables broadly meeting the specifications of the

example cable given below are likely to be suitable.

Example of a preferred cable type:

PARAMETER VALUE

Type
BELDEN ‘Datalene’ series 
No. 9729 2-pair

Characteristic impedance 100 ohms

Capacitance (core to core) 41 pF/m

Capacitance (core to screen) 72.5 pF/m

DC resistance (core) 78.7 ohms/km

DC resistance (screen) 59.1 ohms/km
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FAILURE MONITORING ON 70 V/100 V
CONNECTION.

If the Intellivox is equipped with an input module that
supports direct interfacing to a 70 V/100 V signal, a simple
failure monitoring scheme requiring no additional
connections can be easily implemented.

This scheme is based on impedance switching of the first 70
V/100 V input. An amplifier that is driving this input should
be capable of detecting changes in connected impedance.

Impedance switching is supported for input boards PCB960
(see fig 16) and PCB124 (see fig 17). Configuration details
of the impedance switching are depending on the input
board type as described hereafter.

Reconfiguring the failure monitoring requires
access to an internal jumper.

This requires the electronics module to be carefully
removed from the enclosure by a qualified engineer.

Ensure that all connectors are unplugged before removing
the electronics module.

Configuring PCB960

The impedance between pin 1 and 2 of the audio input

connector has two states:

• High impedance (approximately 100 kOhm @ DC).

• Low impedance (approximately 2.2 kOhm @ DC).

The states are switched by a separate change-over contact

of the Intellivox's internal Failure Relay.

An internal jumper (JMP1) on the input board determines

the impedance states:

• Low impedance if the device status is OK, High

impedance if the device has a failure or is not powered. This

is the factory default configuration, the jumper is placed on

the contact pins of JMP1 that are closest to CONN1

(furthest away from the edge of the board, see fig 16).

• High impedance if the device status is OK, Low

impedance if the device has a failure or is not powered. The

jumper should be placed on the contact pins of JMP1

closest to the edge of the board.

• Always High impedance, regardless of the device status.

The jumper should be removed.   

CONFIGURATION JMP1 NOTES

High-impedance on failure Towards CONN1 Factory default

Low-impedance on failure Towards PCB edge -

Always High-impedance Removed -

fig.16 - Input board PCB960 with location of
jumper JMP1
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Configuring PCB124

The impedance between pin 1 and 2 of the audio input

connector has two states:

• High impedance (approximately 140 kOhm @ DC).

• Low impedance (approximately 2.2 kOhm @ DC).

The states are switched by a separate change-over

contact of the Intellivox's internal Failure Relay.

An internal jumper (JMP2) on the input board determines

the impedance states:

• Low impedance if the device status is OK, High

impedance if the device has a failure or is not powered.

This is the factory default configuration, the jumper is

placed on both contact pins of JMP2 (see fig 17).

• Always High impedance, regardless of the device status.

The jumper should be removed.

Notes

• The fault conditions that result in impedance switching

are user definable (these are the same as for the internal

Failure Relay, see section Fault Monitoring on page 13 for

details).

• The High impedance state is affected by the option 'DC

blocking' (as for example offered by part # 381005). In

case of the 'DC blocking' option, series capacitors result

in a very high input impedance for DC. The Low

impedance state is not affected by the 'DC blocking'

option.

CONFIGURATION JMP2 NOTES

High-impedance on failure Present Factory default

Always High-impedance Removed -

fig.17 - Input board PCB124 with location of
jumpers JMP1 and JMP2
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FAILURE RELAY CONFIGURATION

Intellivox units equipped with input board PCB124 (see

fig.17) support configuration of the internal Failure Relay

for either volt-free or impedance-sensing  (10k / 20k Ω)

operation.

Reconfiguring the internal Failure Relay

requires access to an internal jumper.

This requires the electronics module to be carefully

removed from the enclosure by a qualified engineer.

Ensure that all connectors are unplugged before

removing the electronics module.

An internal jumper on the input board (JMP1) defines 

the operation:

• Volt-free mode:

In volt-free operation, COM is connected to NC; a

failure condition causes COM to be connected to NO.

This is the factory default configuration, the jumper is

placed on the contact pins of JMP1 that are closest to

R29 (furthest away from the edge of the board, see fig 17).

• Impedance sensing mode:

When configured for impedance-sensing use, the

impedance between COM and NC is 10k Ω and open-

circuit between COM and NO in normal operation.

When a fault condition occurs, the impedance between

COM and NC rises to 20k Ω, and COM is short-circuited

to NO. The jumper should be placed on the contact pins

of JMP1 closest to the edge of the board.

NONCCOM

Connect to NO or
NC as required

INTERNAL RELAY

VOLT-FREE
CONFIGURATION

NOTE: Relay shown in
energised state - i.e., ‘no

fault’.

fig.18 - Volt-free mode

2 x 10 kΩ

INTERNAL RELAY

IMPEDANCE-SENSING
CONFIGURATION

NOTE: Relay shown in
energised state - i.e., ‘no

fault’.

NONCCOM

fig.19 - Impedance-sensing mode

CONFIGURATION JMP1 NOTES

Volt-free Towards R29 Factory default

Impedance-sensing Towards PCB edge -



JBL Professional
8500 Balboa Boulevard 

Northridge, CA 91329 U.S.A.
© Copyright 2014 JBL Professional

www.jblpro.com


